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1 Introduction

1.1 Online help

All the dialog boxes and windows in the TC-08 software have some associated help
information. To receive help in the context of a dialog box, click the Help button on the

dialog box. To receive help in the context of a window, click . For a step-by-step
introduction to the software, select Guided tour from the Help menu. Alternatively, with
the help file open, do one of the following:

  Click on the Contents tab and choose a chapter for browsing
  Click on the Index tab and search on a keyword
  Move on to the next topic by clicking the >> button

1.2 Overview

The TC-08 software is a data acquisition tool that collects, records, displays and analyses
measurement data. It has the following capabilities:

  Will collect blocks of data at high speed from a single converter
  Will collect data at low speed over long periods from multiple converters
  Allows you to adjust Alarm settings for measurements you want to take
  Enables you to apply Parameter scaling, using equations or tables
  Allows you to Edit calculated parameters
  Can analyse other files during data collection
  Displays data during slow collection and after collection
  Graphical display, if you activate the PLW XY Graph window or PLW Graph window,
and spreadsheet display if you activate the PLW Spreadsheet window

  Will transfer data to other applications via clipboard, file or DDE
  Will transfer data between computers using IP sockets
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1.3 Recording

The recording mode and repeat functions are selected using the Recording dialog box.
The TC-08 software can record in the following ways:

  Real time continuous
This offers continuous recording over long periods. The data can be displayed in
graphical or spreadsheet format during data collection. The fastest sampling rate in
realtime mode depends on the speed of the computer and the operating system (it is of
the order of a few milliseconds).

  Fast block (single converter only)
This is used to collect a relatively short block of data at high speed. It is not possible to
display data during block mode recording. In block mode, it is possible to start
recording on a trigger event. If the 'repeat immediately' option is selected, it is possible
to write a run file for each occurrence of the trigger event.

There are several options to specify what should happen at the end of a run when the
specified maximum number of samples have been collected. The options are as follows:

  Stop
  Repeat immediately
  Scroll
  Repeat after delay

1.4 Safety warning

Do not connect the ground input of the ADC to anything which may be at some voltage
other than ground, as you may risk damage to the ADC and your computer. Furthermore,
if you connect the ADC ground to something which is live, your computer chassis may
become live.

If in doubt, check by connecting a channel input to the doubtful ground point, and check
that there is no significant AC or DC voltage.

We strongly recommend that you read the general safety information in your installation
guide and also the product-specific safety warning in the product manual before using
your product for the first time.
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2 TC-08 software components

2.1 Introduction

The TC-08 software is made up of a number of separate components but you need only
activate the components that you wish to use.  As a result, the screen is not cluttered with
data that you are not using and the computer can easily be used for other applications
whilst you are recording.

The application components that are available are as follows:

PLW Recorder
Enables you to start and stop recording and to specify recording files, the measurements
currently being taken and the alarm state.

PLW Player
Enables you to scroll quickly and easily through stored files to compare results on
successive runs.

PLW Graph
Shows the readings for single or multiple measurements over a period of time.

PLW XY Graph
Shows the readings of one measurement against another, on the same graph.

Spreadsheet
Shows detailed or summary information in a format which can be copied to a clipboard.

Notes
Enables you to enter information for a particular run.

When you start the TC-08 software in recorder mode, the computer displays the recorder
application. The player application and display windows can be selected from the 
Window menu.

When you start the TC-08 software in player mode, the computer displays the player
application. The recorder application and display windows can be selected from the 
Window menu.
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2.2 PLW Recorder

When you start the TC-08 software using the Recorder icon, the computer displays the
monitor window, which looks like this:
  

At the top is a menu bar containing the File, Settings, View and Help menus. Below the
menu bar are two sets of controls, the Recorder controls and the Window controls. 

Recorder controls

 - New file. Specify a new file to record to.

 - Re-record. Rewind the current file so that it can be re-recorded.

 - Start recording. 

 - Pause/resume. 

 - Stop recording. 

 - Help. Access the help information for the recorder window (this page).

Window controls
The second group of buttons, on the right, is used to open other windows:

 - View Notes. Open a Notes window.

 - View Graph. Open a PLW Graph window.

 - View spreadsheet. Open a Spreadsheet window.
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Range indicators
The lower pane of the window contains a line of information for each selected
measurement. At the beginning of each line is an indicator lamp that signals the current
status of the readings taken by the TC-08 software:

 - The measurement value is within range

 - The measurement value is currently out of range, but has not been out of range long
enough to trigger an alarm

 - The measurement value is in an alarm state. To cancel the alarm, use the mouse to
click on the lamp

 - The measurement value is in an alarm state, but the alarm has been cancelled

Next to each lamp is the name of the measurement and its current value. If you click on a
measurement name, the computer will display the details of the measurement.

2.3 PLW Player

When you start the TC-08 Player, or you select Player from the View menu of the TC-08
Recorder, the computer opens a new window like this:
 

This shows you the name of the current Player File and the number of samples taken so
far.

Player controls
The buttons on the left are used to specify a filename and to go forwards or backwards in
a file sequence. The controls are as follows:

 - Open file. Load a new file into the player.

 - Back a file. Go to the previous file in a sequence.

 - Forwards a file. Go to the next file in a sequence.

Window controls
The buttons on the right are used to open other windows:

 - View Notes. Open a Notes window.

 - View Graph. Open a PLW Graph window.

 - View spreadsheet. Open a Spreadsheet window.
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2.4 PLW Graph

From the View menu of the TC-08 Recorder or Player, select Graph.

Note that there are several graph options that affect the way that the graph is displayed
and the format of the axis scales.

The group of horizontal buttons in the top right corner of the screen selects what time
interval is displayed:

  - Scroll left. Move a whole display left.

  - Scroll quarter left. Move a quarter display left.

  - Expand horizontal axis. Magnify the middle half of the display to fill the whole
width.

  - Shrink horizontal axis. Shrink the current display to half size, so that more is
displayed before and after.

  - Scroll quarter right. Move a quarter display right.

  - Scroll right. Move a whole display right.

The upper group of vertical buttons controls the vertical range displayed. If there is more
than one graph frame, the buttons control the frame with the thicker border. To switch to a
different frame, point inside the new frame with the cursor and click the left mouse button.

  - Scroll up. Move a whole display up.

  - Expand vertical axis. Magnify the middle half of the display to fill the whole height.

  - Shrink vertical axis. Shrink the current display height to half size, so that more is
displayed above and below.

  - Scroll down. Move a whole display down.

Note that if you use these controls to change the time or vertical range, auto-scaling for
that axis is turned off automatically. Use the options to turn auto-scaling back on again
(see button below).
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The remaining vertical controls are:

  - Copy to clipboard. Copy the graph to the clipboard.

  - Print view. Print the graph.

  - New file. Write graph to file in .bmp, .jpg, or .wmf format.

  - Select channels. Select the measurements to display on the graph.

  - View options. Specify the options for the graph.

  - Help. Access the help info for the graph window (this page).

If you move the mouse cursor onto the graph part of the screen, the computer will display
the measurement value and time at the current cursor position. If you click the left mouse
button, the graph will zoom in, centred on the mouse cursor. If you click the right mouse
button, the graph will zoom out, centred on the mouse cursor.

2.5 PLW XY Graph

From the View menu of the TC-08 Recorder or Player, select XY Graph.

There are several buttons in the top right corner of the screen. The top row of buttons
controls the horizontal range displayed:

  - Scroll quarter left. Move a quarter display left. 

  - Expand horizontal axis. Magnify the middle half of the display to fill the whole
width.

  - Shrink horizontal axis. Shrink the current display to half size, so that more is
displayed.

  - Scroll quarter right. Move a quarter display right 
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The upper group of buttons in the column on the right controls the vertical range
displayed:

  - Scroll up. Move a whole display up.

  - Expand vertical axis. Magnify the middle half of the display to fill the whole height.

  - Shrink vertical axis. Shrink the current display height to half size, so that more is
displayed above and below.

  - Scroll down. Move a whole display down.

Note that if you use these controls to change the horizontal or vertical range, auto-scaling
for that axis is turned off automatically. Use the options to turn auto-scaling back on again
(see buttons below).

The remaining vertical controls are:

  - Copy to clipboard. Copy the graph to the clipboard.

  - Print view. Print the graph.

  - Select channels. Select the measurements to display on the XY graph (only two).

  - View options. Specify the options for the graph.

  - Help. Access the help info for the graph window (this page).

If you move the mouse cursor onto the graph part of the screen, the computer will display
the measurement values at the current cursor position.

2.6 Spreadsheet

From the View menu of the TC-08 Recorder or Player, select Spreadsheet.

There is one line for each reading. The first column shows the time in seconds, while the
remaining columns show the selected measurements. 
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The following options buttons are available:

  - Select channels. Select the measurements to display.

  - View options. Spreadsheet options specify whether to display individual readings,
or first reading, average, minimum and maximum for a period.

If you select a range of readings, you can use the following buttons:

  - Write to disk. Write the readings to a print file (.prn) or a text file (.txt) - Both are tab
separated value files.

  - Copy to clipboard. Write the readings to the clipboard.

  - Print view. Print the graph.

You can select a range in one of three ways:

If all of the readings that you want to select are on the screen:
       

  Point the mouse at the first reading 
  Press and hold down the left mouse button 
  Drag the mouse to the last reading (the selected readings will be highlighted as you go)

and
  Release the left mouse button.

If the readings are a long way apart:

  Point the mouse at first reading 
  Click the left mouse button (this will highlight the first reading) 
  Scroll down to the last reading 
  Point at the last reading  and
  Press the shift key and click the left mouse button.

If you wish to select all of the readings for one day:

  Point the mouse at any reading during the required day 
  Click the left mouse button (this will highlight the reading)  and

  Click on the 'select day' icon: 
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2.7 Notes

From the View menu of the TC-08 Recorder or Player, select Notes.

This window enables you to enter information for a particular run. This is useful if you
carry out a number of similar runs. The report title can be the same for every run, but the
notes contain information specific to each run.

If you have a Notes window open when you use the player to browse through several
runs, the notes for each run will be displayed. The notes also appear on printed reports.
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3 How to...

3.1 Add new measurements

1. Select the TC-08 converter in the normal way 
2. At the measurement list dialog box, select the TC-08 channels to be used
3. Select thermocouple type for each channel to be used
4. Click the Scaling button
5. Enter the scaling details (see Parameter scaling dialog box for details).

3.2 Select which measurements to display

When you first open a graph or spreadsheet window, the computer displays only the first
measurement. To select a different measurement or to add further measurements:

1. Click on the Select channels button: . The computer will display the Select
parameters dialog box, with a list of all of the                     
measurements and which ones are in use

2.  Click on each measurement that you wish to be active
3.  Click the OK button

3.3 Start a new run

To start a new run from scratch, select New settings from the File menu.  The TC-08
software will take you through the steps necessary to define what you want to collect:

  Recording method (real time continuous or fast block)
  Sampling Rate, including sampling interval and maximum number of samples
  Converter details
  Channel setup.  The computer will display the Edit TC-08 Channel dialog box.

Once you have entered these details, check that the monitor window in PLW Recorder is
displaying the measurements that you wish to record, and that the correct values are
showing.

1. If you are in TC-08 Player, from the View menu, select Recorder, otherwise go straight
to step 2

2. The PLW Recorder window has buttons like a tape recorder, to start, stop, rewind etc.

3. Click on the New file button: 
4. Type in the name of the file to which you wish to record
5. Click OK (the filename will appear in the recorder window)

6. Click on the Start recording button:  
The sample number will increase every sample interval
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3.4 Repeat an existing run

If you have just recorded a run, and you wish to retain the data, yet start a new run:

1. Click on the New file button: . Note: Do not attempt to save your data directly to a
floppy disk. The computer will display the next sequence-numbered file name.

2. If you do not wish to use the default filename, type in a different name.
3. Click OK

4. Click on the Start recording button: 

If you have just recorded a run, and you wish to discard the data and start a new run:

1. Click on the Re-record button: 

2. Click on the Start recording button:  

If you wish to repeat a run that you did some time previously:

1. From the File menu, select Open.
2. Select the file that you wish to repeat.
3. From the View  menu, select Recorder. This displays the recorder window.
4. Proceed according to the retain or discard options described above.

3.5 Start recording whenever Windows starts

First, save the settings for the type of run that you wish to start:

1. Define the type of run that you wish to carry out
2. Select Save as... from the File menu
3. Type in a filename for these settings
4. Change the file type to .pls
5. Click OK

Note: Do not attempt to save your data directly to a floppy disk.

1. Click the Start button
2. Select Settings or Control Panel
3. Select Taskbar and Start Menu
4. Click Start Menu
5. Click Add
6. Type in c:\Program Files\TC08\plw32.exe -r fred.pls (or whatever your

settings file is called) and click OK
7. Select the startup folder (programs in the startup folder are run automatically when

Windows starts) and click OK
8. Click the Finish button
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3.6 Display data

To display the data in graphical or spreadsheet format, you should first Start a new run. 

You can then display the data by clicking on the appropriate button in the recorder
window:

  - View Notes. Opens a Notes window.

  - View Graph. Opens a Graph window.

  - View spreadsheet. Opens a Spreadsheet window.

Alternatively, select the window type from the View menu.

3.7 Print data

To print a graph:

1. Open a graph window
2. Alter the settings to display the data that you wish to print

3. Click on the Print view button: 

To print a spreadsheet:

1. Open a spreadsheet window
2. Alter the settings to display the measurements that you wish to print
3. Point at the first reading that you wish to print
4. Click the left mouse button to highlight the reading
5. Point at the last reading that you wish to print
6. Hold down the shift key and click the left mouse button to highlight the whole block

7. Click on the Print view button: 
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3.8 Export data to a spreadsheet

To export data to a spreadsheet:

1. Open a TC-08 spreadsheet window
2. Alter the settings to display the measurements that you wish to export
3. Point at the first reading that you wish to print  
4. Click the left mouse button (this reading will be highlighted) 
5. Point at the last reading that you wish to print 
6. Hold down the shift key and click the left mouse button (the whole block will be

highlighted) 

7. Click on the Copy to clipboard button:  
8. Move to the spreadsheet program 
9. Point at the top left of the area you wish to fill  and
10. Select Paste from the Edit menu.

Alternatively, you can click on the New file button, , then write the data to a text file.
You can then import the text file into a spreadsheet.

Note: Do not attempt to save your data directly to a floppy disk.

If you wish to have the readings in the spreadsheet updated continuously with the current
readings, you can use DDE.

3.9 Export a graph to a word processor

To export a graph to a word processor:

1. Open a graph window. 
2. Alter the settings to display the graph that you wish to export. 

3. Click on the Copy to clipboard button:  .
4. Move to the word processor program. 
5. Point at the place to insert the picture.
6. Select Paste from the Edit menu.

Note: Do not attempt to save your data directly to a floppy disk.

Alternatively, you can click on the New file button: , then write the data to a .wmf file.
You can then import the graphics file into the word processor.

3.10 Enable date and time scaling on a graph

The time axis of a graph normally shows the time (in the selected sample interval units)
since the start of the run. Whilst this is convenient for short runs, it is not ideal when
collecting data over longer periods. 

1. Click on the View options button:  
2. Change the time format to Date/Time

Other axis scale formats can be selected in the same way - see the Graph options dialog
box for more details.
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3.11 Transfer data over an IP network

The TC-08 software IP socket facility is used to take measurements on one or more
computers, and record the data on another computer.

The measurements are taken by the TC-08 software on the Server. Another computer,
the Client, requests the data via an IP network.

On the server:

1. Click Start 
2. Select Run... 
3. Type in winipcfg.exe
4. Note the server name

On the client:

1. Open a DOS box 
2. Type in ping followed by the server name
3. The computer will display the time taken to send a message to the server and receive

a response
4. Check that it is working and note the time

On the server:

1. Start up the TC-08 software 
2. From the File menu, select Preferences
3. Select IP Sockets 
4. Check the Enable Server box 
5. Click OK
6. Set up the TC-08 software to measure the channels that you require

On the client:

1. Start the TC-08 software 
2. From the File menu, select Preferences
3. Select IP Sockets 
4. Check the Enable Client box 
5. Exit and restart the TC-08 software 
6. Select New Settings 
7. Enter recording details and click OK 
8. Enter the sampling details and click OK 
9. Select Socket in the converter type combo box 
10. Click OK 
11. Type in the server name, eg fred 

Note: Server names are case sensitive! Fred is not the same as fred 
12. Click Connect 
13. The computer should now display the channels from the server 
14. Click on one of the channels 
15. If you want to change the name, type in the local name 
16. Click OK 
17. The channel you selected is marked with an X 
18. Repeat for each of the channels 
19. Click OK
20. The monitor window should now display the readings from the server
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3.12 Run multiple recorders

There are two limitations to using the multiple converters mode in the TC-08 software:

  Data is collected at the same rate for each device
  A single trigger will start the recording for all converters

If you need to overcome these limitations, two separate instances of the TC-08 Recorder
can be loaded. If you have tried this previously, you will have noticed that simply
attempting to load the TC-08 Recorder from the Start menu twice will load the TC-08
Player.

You will need to create settings files for the configuration of each converter or each set of
converters (use multiple converters mode):

1. Attach one (or the first set) of the converters to the PC 
2. Start the TC-08 software, select New Settings from the File menu, then follow the

sequence of dialogs to setup your Converter(s) 
3. Select Save as... from the File menu, and from the drop down box, select .pls (settings

file), then save
4. Disconnect the first converter and attach the second (or the second set) , then repeat

the steps above.

Once you have a settings file for each converter or set of converters, you will need to start
the TC-08 Recorder from the command line.

1. From the Windows Start menu, select Run... 
2. Type C:\Program Files\TC08\plw32.exe C:\Program

Files\TC08\mysettings1.pls (where C:\Program Files\TC08\ is your
installation directory, and mysettings1.pls is your first settings file)  and

3. Repeat the steps above for each of your settings files (eg - mysettings2.pls, etc).

Note: None of the converters should be running in fast block mode  (this will take
precedence, and inhibit other converters from recording during this period).
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4 Menu bar

4.1 File

To access this menu, from the menu bar of the TC-08 Recorder, select File.

The file menu appears on the menu bar at the top of the monitor window in PLW
Recorder. 

New settings
This menu option erases the current settings and then takes you, step by step, through
the process of setting up the TC-08 software to collect some data. 

New data
This menu option enables you to open a new file to record your data. If you save the file
as a setup file, only the settings are stored. If you save it as a data file, both the settings
and data are stored. You can also save the file as a text file only.

Open
This menu option closes all active windows and then opens a data or setup file.

If you open a data file, the settings and data are copied from the file, and the data is
displayed. If you open a setup file, only the settings are recovered: no data is displayed
until you start the TC-08 software running.

Save as...
This menu option asks for a filename and then writes the data to that file.

If you save the file as a setup file, only the settings are stored. If you save it as a data file,
both the settings and data are stored. You can also save the file as a text file only.

Delete File
This menu option enables you to delete a file. Select the file and then click OK to delete it.
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Preferences
This group of menu options enables you to customise the TC-08 software for Windows:

Colours - enables you to select the colours that the TC-08 software will
use.
Sound - enables you to select the sounds for certain events.
Temperature - enables you to select the units for temperature
measurements.
IP Sockets - activates the IP network facility, allowing you to transfer
data between two computers running the TC-08 software.
Converter - used to specify what converter is to be used. 
Recorder - used to specify whether the Re-record and Pause buttons
are displayed in the Recorder window.

Exit
This menu option exits from the program.

Note: Do not attempt to save your data directly to a floppy disk.

4.2 Settings

To access this menu, from the menu bar of the TC-08 Recorder, select Settings.

The settings menu appears on the menu bar at the top of the monitor window in PLW
Recorder.

Recording
This menu option enables you to choose the recording method for your measurements. 

Sampling...
This menu option enables you to specify the sampling rate and the action at the end of a
run.

Input channels...
This menu option enables you to specify the converter and port that will take the
measurements.

Calculated parameters
This menu option enables you to enter details for measurements which are calculated
from one or more other measurements. This can be done either during data collection or
after the data has been collected.

Monitor
This menu option enables you to select the measurements that you wish to display in the
monitor window. To select a measurement, highlight it and then click OK.
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4.3 View

To access this menu, from the menu bar of the TC-08 Recorder or Player, select View.

Player
This menu option creates a new Player window.

Notes
This menu option creates a new Notes window.

Spreadsheet
This menu option creates a new Spreadsheet window.

Graph
This menu option creates a new Graph window.

XY Graph
This menu option creates a new XY Graph window.
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4.4 Help

To access this menu, from the menu bar of the TC-08 Recorder, select Help.

The Help menu appears on the menu bar at the top of the monitor window in PLW
Recorder.

Index
This menu option takes you to the index of the TC-08 software help file.

Contents
This menu option takes you to the contents page of the TC-08 software help file.

Using help
This option explains how to use the TC-08 software help file.

This view
This option explains the operation of the monitor window in PLW Recoder.

Guided tour
This menu option shows you the main features of the program. A converter need not be
connected.

About...
This menu option gives the version and serial number of this instance of the TC-08
software.

4.5 Keyboard shortcuts

You can control some of the TC-08 software's functions using the following keys on the
keyboard:

Key Function
Alt-P open Player View
Alt-N open Notes View
Alt-S open Spreadsheet View
Alt-G open Graph View
Alt-X open XY Graph View
F1 view Help index
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5 Dialog boxes
5.1 General dialog boxes

5.1.1 Recording

To access this dialog box, open the Settings menu of the TC-08 Recorder and select
Recording.

This dialog box is used to specify which recording method will be used.

The options for Recording method are as follows:

  Real time continuous
In real time continuous mode you can record the data at the same time as displaying it
in graphical or spreadsheet form. The maximum sampling rate is one per millisecond.
With this method, you can use multiple converters.

  Fast block
In fast block mode, data is collected at high speed but cannot be displayed until after it
is collected. The sampling rate is controlled by the converter. This method is limited to
a single converter.

Use multiple converters
Check this box if you wish to use more than one converter. This option is not available for
fast block recording.

Action at end of run
This defines what happens when all the samples have been collected. Choose one of the
following options:

  Stop
Means stop collecting

  Repeat immediately
Means start a new run immediately after completing the current run

  Repeat after delay
Means start a new run after the restart delay has elapsed. This could be used to collect a
one-minute block of data once per hour

  Scroll
Means that new samples will be recorded and the oldest samples will discarded. This is
useful if you only wish to have a record of the most recent samples
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When you select a repeat option, the computer automatically increments a sequence
number at the end of the filename.

Restart delay
When in 'repeat after delay' mode, this is the time interval from the start of one run to the
start of the next run.

5.1.2 Sampling Rate

To access this dialog box, open the Settings menu of the TC-08 Recorder and select
Sampling...

This dialog box sets the sampling rate and defines the action to take at the end of a run.

Sampling interval
To set the interval between samples, type a number in the box and select the required
units. The interval must be a whole number so, for example, 30 seconds must be
specified rather than 0.5 minutes.

Note: When you have set sampling intervals of less than a second, displaying a graph
whilst data recording is possible, but may interfere with recording.

Maximum number of samples
To set the maximum number of samples to be collected during a run, enter the maximum
in this box. The maximum can be up to a million samples. During real-time data collection,
the sampling can be stopped at any time, so you can enter a large number and then stop
the run early.

Readings per sample
Normally the TC-08 software takes as many readings as possible during each sample
period, then saves the average of the readings. If you need an instantaneous
measurement, (for example, if you wish to calculate standard deviations), change this
option to Single.
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5.1.3 Print

To access this dialog box click  when one of the display windows is open.

Printer:
At the top is a combo box with the name of the default printer. You can select a different
printer if you wish.

Setup
Use the Setup button to open a dialog box with setup information specific to the selected
printer.

Once all the details are correct, click OK to start printing.

5.1.4 Confirm File delete

If you want to delete a TC-08 software file you have saved on your hard disk, open the 
File menu of the TC-08 Recorder and select Delete File.  A window appears showing you
the list of files in the active directory.

Double-click on the name of the file you want deleted. The following dialog box appears.

If you are certain you want to go ahead with deletion, click the OK button. 
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5.1.5 Converter-related

5.1.5.1 Converter details

To access this dialog box, select Input channels... from the Settings menu.

This dialog box is used to specify the details for a converter. Note that it is not displayed if
you set the Converter preferences to automatically select a particular converter.

USB Devices
A list of USB devices of the selected type that are currently attached to the PC will be
displayed.

When attempting to edit the settings of a currently opened unit, then the unit that you are
editing will appear highlighted at the bottom of the list. If non-highlighted units appear at
the top of this list, these represent other available devices of this type attached to the PC.
You can freely switch between these available units, however, the settings of the unit you
are editing will not be saved.

Note: Enumerating USB devices can take some time, especially if a number of USB
devices are attached to the PC.  The TC-08 software may appear to lock up during this
period, but this is normal.

Refresh
After you have selected a converter from the Converter type drop-down list, click this
button to scan for new USB devices.

Status
This informs you of the status of any converters you have attached to your computer. To
ensure that your hardware is setup correctly, see the section on hardware setup.

OK
When you click the OK button, the computer will open a measurement dialog box for the
selected converter.  A double-click with the mouse on the desired USB device will also
have the same effect.
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5.1.5.2 Converters

To access this dialog box, click the OK button on the Converter details dialog box. Note:
If the Use multiple converters box is ticked on the Recording dialog box, selecting
Input channels... from the Settings menu will take you directly to the Converters dialog
box.

This dialog box is used to build up a list of converters to use. In the pane on the left will be
a list of the converters that are currently active.

Add...
To add another converter to the list, click the Add... button. This will open the Converter
details dialog box so you can enter the type and port for the new converter.

Edit...
To edit the details for an existing converter, highlight the entry for it and click the Edit...
button. This will open the Converter details dialog box.

Delete
To remove a converter from the list, highlight the converter and click the Delete button.

Parameters...
To specify the measurements to be measured for a converter, highlight the converter and
click the Parameters... button.
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5.1.5.3 Converter preferences

To access this dialog box, open the Preferences sub-menu in the File menu and select
Converter.

So that the computer does not ask each time you define new settings, you can specify in
advance which converter to use. The options available are as follows:

  Ask during configuration
Ask for the converter every time you enter new settings

  Use converter specified during install
Use the converter specified when the TC-08 software was installed

  Use converter specified here...
Use the converter specified in this dialog box

When you select the last option, the computer enables the converter and port fields on the
dialog box.
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5.1.6 IP socket-related

5.1.6.1 IP Socket options

To access this dialog box, open the Preferences sub-menu in the File menu and select
IP Sockets. 

This dialog box is used to specify the details required to establish a link between
computers via an IP network.

One computer is referred to as the server. This is the computer supplying data. The other
computer is referred to as the client. This is the computer receiving data. It displays the
measurements as if they are being collected locally. A server can support any number of
clients, and a client can get data from up to 10 servers.

Server enabled
When this option is selected, the TC-08 software will start responding to requests for data
from any the TC-08 software clients that contact it.

Client enabled
This sets this computer to act as a client. When it is checked, the socket device appears
in the Select Device dialog box. 

Server socket
This specifies what IP socket the server will use. It is not normally necessary to change it,
unless the socket is already in use by another application. If you change it, you must do
so on the server and on all clients.

Response timeout
This only has an effect on the client. It controls how long the client will wait for a response
from the server. You can use the PING command to find out how long a round trip
normally takes.

Minimise network traffic
If this box is not checked, the client will continuously request data from the server. This is
OK over a local network, but could cause a dial-up bridge between two subnets to stay
active all the time. If you check this box, the client only asks for data once per sample
period. With a sample period of an hour, the client will only contact the server once per
hour.
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5.1.6.2 Socket channels

Accessed from the Converter details dialog box. Note: Only accessible when Client
enabled has been checked on the IP Socket options dialog box and Socket has been
selected as the Converter type in the Converter details dialog box.

This dialog box is used to establish a connection to another instance of the TC-08
software running on a remote server computer, and then to select the channels that are to
be imported to this instance of the TC-08 software.

Server
This is the name of the server. If it is on your local network, the computer name should be
enough (for example, "carnot"). If you want to communicate via a large network or the
internet, you will need to put the full name of the computer, for example,
"carnot.omega.com". 

Connect
Having entered a server name, click the Connect button to establish a link to the server.
If successful, a list of channels (corresponding to measurements) available on the server
will appear. If someone changes the details on the server, you can click this button to
update the details locally.

Edit...
To edit a channel, first select it, then click this button. The Edit socket channel dialog
box will appear so that you can enter the details.

Disable
To disable a previously selected channel, highlight it and click this button.
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5.1.6.3 Edit socket channel

To access this dialog box, click the Edit... button on the Socket channels dialog box.

This dialog box is used to enter the details for a channel.

Name on
server
This is the name of the channel on the remote server computer. It cannot be changed
from the local computer.

Local name
This is the name of the channel as it will appear locally.

Options...
To set the Parameter options, click the Options... button.

5.1.6.4 Device status

To access this dialog box, click the Status button on the Converter details dialog box.
 

This dialog box displays the details about the IP socket connection to the server.
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5.1.7 Parameter-related

5.1.7.1 Parameter options

To access this dialog box, click the Options... button on the measurement dialog box for
the converter. If you are using a TC-08, for example, the measurement dialog box for the
converter would be the Edit USB TC-08 Channel dialog box.

This dialog box is used to set up measurement definitions. 

Use Parameter Formatting
By default, the measurement or channel that has been setup will use its own default
values for formatting. If you want to use your own scaling, click the Scaling button. It is
recommended that you tick the Use Parameter Formatting check-box and enter your
own values in the fields described below.

Units
The units you enter here will appear on spreadsheets and graphs.

Number display
This defines the format of the information for spreadsheet entries and graph scales. For
example, with a field width of 6 and 2 decimal places, a number will appear in the format 
ddd.dd. The field width must be between 1 and 8, and the number of decimal places
must be less than the field width.

Scaling for graphs
This defines the maximum and minimum values to be used for graphical displays.

Note: Any scrolling in the PLW Graph window is based on these numbers, and limited by
them. Once you have saved your data, these cannot be changed, so ensure that these
limits extend up to or beyond the maximum data values you expect to capture.
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Scaling
The Scaling button opens the Parameter scaling dialog box, which can be used for the
following two purposes:

  Converting an input voltage into some other units
  Applying minor scaling corrections to values that have already been scaled for a

particular signal conditioner and sensor

Alarm
The Alarm button opens the Alarm settings dialog box for this measurement definition.

5.1.7.2 Parameter scaling

To access this dialog box, click the Scaling button on the Parameter options dialog box.

This dialog box is used to specify how to convert a measurement value into some other
unit, for example from volts to temperature. It is invoked when you click the Scaling button
on the Parameter options dialog box.

Scaling Method
There are three scaling methods: None, Table lookup, and Equation. You can also read in
a lookup table or an equation from a file.

Table lookup
This is useful for a set of input readings corresponding to different values of the
measurement to be scaled. You can put two or more pairs of values in the box below. For
example, to convert a 0 to 2.5V input to  minus 40 to 100C, enter the following details in
the box:

                 0                       -40
               2.5                     100

Two pairs is sufficient if there is a linear relationship between the raw and scaled values.
For non-linear relationships, the required number of pairs depends on the maximum
acceptable interpolation error. If you wish to enter more than half a dozen pairs of values,
it is better to enter the table into a file, and then use file scaling (see below).
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Equation 
This can be used when it is possible to calculate the relationship between the input
reading and the measurement value. The raw measurement values is represented by x.
For example, to convert a temperature from Fahrenheit to Celsius, the equation would be:
 

 (x-32)* 5 / 9

For more information on equations, see equation notation.

File
When you specify that you wish to use a file for scaling, this button is enabled. When you
click this button, the computer opens up a dialog box to select a scaling file.

Scaling from file 
If you wish to scale the inputs from a number of identical measurements using the same
method, or if you wish to set up a large lookup table. See Scale file format for more
information on the format.

5.1.7.3 Alarm settings

This dialog box defines the alarm settings for each measurement. It is invoked when you
click the Alarm button on the Parameter options dialog box.  To access it, click the
Alarm button on the Parameter options dialog box.

Enable the alarm
If you wish to enable alarm limits for this measurement, check this box.

Lower and upper thresholds
If the measurement goes out of this range, the alarm will sound.

Holdoff
If the measurement value occasionally goes out of range for short periods, you can
prevent this causing an alarm by setting a holdoff period. The alarm will then sound only if
the measurement stays out of range for longer than the holdoff period, measured in
seconds.
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5.1.7.4 Select parameters

In the context of the monitor window in PLW Recorder, you access this dialog box by
selecting Monitor from the Settings menu.

On the PLW Graph, PLW XY Graph, and Spreadsheet windows, click . This is the
measurement selection button.

The selected measurements are highlighted. To select or de-select a measurement,
simply point and click.

This dialog box is used to select the measurements which will be displayed in a window. 

Group
At the bottom is the group combo-box. You can use this to save and restore a number of
named groups of measurements.

To save the current measurement selection as a group, type in the group name and click 
Save.

To select a saved group, open the combo box and double-click on the requested group.

To modify an existing group, make the changes to the measurement selection then type
in the group name and click Save.

To remove an existing group, de-select all measurements, type in the group name and
click Save.
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5.1.7.5 Calculated parameters

To access this dialog box, select Calculated parameters from the Settings menu.

This dialog box is used to add or edit calculated parameters. Calculated parameters are
readings that need some action performed on them before they can be presented as
measurements. For instance, thermocouple voltage readings cannot be turned into
temperature measurements without the aid of a scaling table.

Unlike raw measurements, with calculated measurements, it is possible to change their
details once a run is completed.

On the left is a list of calculated measurements and on the right are some buttons which
enable you to add, edit or delete calculated measurements.

Add
To add a new calculated measurement, click the Add... button. This will open the Edit
calculated parameter dialog box.

Edit
To edit the details for a calculated measurement, first highlight it and then click the Edit...
button. This will open the Edit calculated parameter dialog box so that you can enter the
details.

Delete
To remove a calculated measurement, first highlight it, then click the Delete button.
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5.1.7.6 Edit calculated parameter

To access this dialog box, click on the Add... or Edit... button on the Calculated
parameters dialog box.
 

This dialog box enables you to edit the details for a calculated measurement. A calculated
measurement is calculated from up to five other measurements, using an equation.

Fields A to E
These fields enable you to select up to five measurements (raw or calculated) which are
to be used in a calculated measurement. If you require less than five input
measurements, unused measurements should be left blank.

Equation
Here you enter the equation that explains how to calculate this measurement from the
input measurements. The input measurements are  represented by A, B, C, D and E.  For
example, to calculate the power output from a boiler, the input measurements might be:

A = inlet temperature
B = outlet temperature
C = flow rate

and the equation would be
 

(A-B) * C * 4120

See the Equation Notation topic for more information.

Options
Set the options (units, range etc) for this measurement from Parameter options.
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5.1.8 Window-related

5.1.8.1 Graph options

To access this dialog box, click  in the PLW Graph window.

This dialog box is used to set the options for the Graph window.

Title
This is the title of the graph that will appear on the graphical reports.

Format
This specifies how traces are to be divided between graphs. The choices are:

  Automatic - the traces are allocated by the computer, putting traces with the same units
on the same graph.

  Separate graphs - each measurement is displayed on a separate graph.
  All traces on same graph  - each measurement is displayed on the same graph

Time axis scale
This allows you to choose how the time axis is scaled:

  Automatic - the scaling is set by the computer.
  Maximum - the time axis is set to the maximum sampling time
  Scroll - the display is scrolled across the screen
  Manual - the scale can be changed by clicking on the scroll left/right tool buttons on the

Graph window.

The time axis scale is automatically set to Manual if you click any of the time scrolling
buttons

Time Format
This allows you to choose the format for the time axis:

  Numeric - the time in the selected sampling time units since the start of the run
  Time since start - the time in hours and minutes since the start of the run 
  Time of day - the real time 
  Date/time - the real time including the date
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Vertical axis scale
This allows you to choose how the vertical axis is scaled:

  Automatic - the scaling is set by the computer.
  Maximum - the axis is set to the maximum 
  Manual - the scale can be changed by clicking on the vertical scrolling buttons on the

Graph window.

The Vertical axis scale is automatically set to Manual if you click any of the vertical
scrolling buttons

Display every xxx samples
If you are displaying a graph while collecting data, this controls how frequently the graph
is updated.  It has no effect after you have finished recording, or when using the player.

When collecting less than a thousand samples, leave it set to 1. When collecting a large
number of points, it may take some time to update the graph, so updating every time a
new reading is taken would be a waste off effort.

Display Markers
When this box is checked and there is more than one trace on the graph, the computer
displays markers (triangles, circles etc) on the traces to help identify the traces.

Auto save on exit
When this box is checked, all graph window settings are saved automatically when you
close the graph window.
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5.1.8.2 XY options

To access this dialog box, click  in the PLW XY Graph window.

Title
This is the title of the graph that will appear on graphical reports.

Horizontal/Vertical axis scale
This allows you to choose how the axes are scaled:

  Automatic - the scaling is set by the computer.
  Maximum - the axis is set to the maximum 
  Manual - the scale can be changed by clicking on the scroll buttons on the XY Graph

window.

The axis scale is automatically set to Manual if you click any of the scroll buttons.

Auto save on exit
When this box is checked, all XY graph window settings are saved automatically when
you close the XY graph window.
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5.1.8.3 Spreadsheet options

To access this dialog box, click  in the Spreadsheet window.

Auto save on exit
When this box is checked, all event window settings are saved automatically when you
close the event window.

Auto scroll
When auto scroll is enabled whilst sampling is in progress, the windowed range is
updated automatically to keep the latest reading visible.

Time Format
This allows you to choose the format for the time:

  Numeric - the time in the selected sampling time units since the start of the run
  Time since start - the time in hours, minutes and seconds since the start of the run 
  Time of day - each sample is labelled with the time it was taken
  Date/time -  each sample is labelled with the date and time it was taken

Show individual/aggregated readings
When show individual readings is checked, the spreadsheet window shows each
individual reading.

When it is cleared, the computer displays results which are aggregates (1st
reading/average/maximum/minimum) of the readings for the time interval specified below.
The controls in the Show aggregated readings box are then enabled. If you select more
than one control, the computer displays the corresponding number of columns for each
sensor in the spreadsheet, and adds a heading (1st reading/average/maximum/minimum)
to each column.

Time interval per row
This specifies the time interval between each of the rows on the spreadsheet. If, for
example, the sampling interval was set for every minute, and you set the time interval per
row to 60, each row will be the (1st reading / average / maximum / minimum) of 60
readings.
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5.1.9 Preferences

5.1.9.1 Colours

To access this dialog box, select Colours from the Preferences sub-menu in the File
menu.

This is used to specify the colours for the background, text and traces for the graph and
spreadsheet windows. To change a colour, click on the colour button to open the colour
selection dialog box.

Background
This is the colour for the background on graphs, and for non-selected readings on the
spreadsheet.

Frame
This is the colour of the frame round graphs.

Grid
This is the colour for the grid on the graphs.

Text
This is the colour for text.

Selection
This is the colour for the selected readings on the spreadsheet.

Traces
A graph can display up to ten traces: the ten buttons along the bottom of the dialog box
are the colours for each trace.
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5.1.9.2 Sounds

To access this dialog box, select Sound from the Preferences sub-menu in the File
menu.

For some events, the TC-08 software can make a sound when an event occurs. This
dialog box allows you to enable the sounds for each type of event.

Beep on each new reading
This option is useful if there is a problem and you need to keep a close check on it. If you
select a graph or spreadsheet window, the computer beeps each time a new reading is
added to the graph or spreadsheet.

Beep when lamp is clicked
When there is an alarm set, the lamp on the monitor window turns red.  You can click on
the lamp to cancel the alarm. When this box is checked, the computer beeps to confirm it
has accepted your request to cancel the alarm.

Beep continuously on alarm
When this box is checked, the computer produces a continuous tone while an alarm is
active.

5.1.9.3 Temperatures

To access this dialog box, select Temperature from the Preferences sub-menu in the
File menu.

This is used to specify the units for temperature measurements. The options are
Fahrenheit or Celsius (Centigrade).
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5.1.9.4 Recorder preferences

To access this dialog box, select Recorder from the Preferences sub-menu in the File
menu.

Some buttons can be disabled to prevent the accidental erasure of data.

Display the re-record button

Chooses whether  is visible in the PLW Recorder window.

Display the pause button

Chooses whether  is visible in the PLW Recorder window.
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5.2 Hardware configuration

5.2.1 USB TC-08 Channels

To access this dialog box, assuming you have already set up the TC-08 software with a
USB TC-08 unit, select Input channels... from the Settings menu.

This dialog box is used to select the channels that will be used to take measurements.

Edit
To select a channel, first highlight it, then click the Edit... button (or double left-click with
the mouse). This will open the Edit TC08 Channel dialog box so that you can setup the
channel.

Disable
To disable a previously selected channel, highlight it in the list window and click the 
Disable button.

Mains Frequency
The USB TC-08 can filter out the noise associated with mains. Select the option
corresponding to the frequency of mains in your country.

5.2.2 Edit USB TC-08 Channel

Accessed via Edit button on the TC08 Channels dialog box.

This dialog box is used to enter the details for a channel.



TC-08 Software User's Guide44

Name
This is the name of the channel. This name will appear on all reports.

Thermocouple
This is thermocouple type connected to the channel. There are eight valid thermocouple
types: B, E, J, K, R, S, T, and N.
There is also a ±78.125 millivolt range.

Filter enable
If you want to use a filter to reduce the effects of electrical noise, check this box.

Filter factor
A median filter is applied when 'filter factor' number of samples have been collected,
returning the middle value. Filtered values are more stable, but respond more slowly to
real changes in temperature. The higher the factor, the stronger the filtering effect will be.

Options
To set the options for a parameter, click the Options... button.

5.2.3 Device status

Accessed via Status button on the Converter details dialog box.

This dialog box displays the details about the ADC status. The calibration date will help
you keep track of when the unit should be returned to Omega for annual recalibration
(optional).
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6 Equipment overview

6.1 USB TC-08

The USB TC-08 works with thermocouples of any standard type, and you can also use
any combination of channels to measure a voltage range of ±70 mV. thermocouples are
cold-junction compensated (the cold junction temperature can be monitored as an extra
channel in the TC-08 software).

The USB TC-08 is compatible with USB 1.1 and supports streaming with a guaranteed
sampling interval of 40 milliseconds per active channel + 40 milliseconds cold junction (for
example, for 3 active channels, the minimum interval is 160 milliseconds).
(the TC-08 software does not currently support streaming operation)

 You can connect up to ten converters to the TC-08 software simultaneously.  These can
all be USB TC-08s for a maximum of 80 thermocouple channels.

6.2 IP sockets

The TC-08 software has built-in support for transferring data over an IP network. 

One computer supplies the data and is referred to as the server. The other computer
(referred to as the client) receives data from the server and displays the measurements
as if they were collected locally. A server can support any number of clients and a client
can get data from up to 10 servers.

A client needs two pieces of information to talk to a server: the name of the server and a
socket number (normally 1050). The server does not need to know anything about the
client.

The link uses the UDP/IP protocol. This is very efficient but does not guarantee that every
message will get through. On large networks, a lost message would result in a delayed
data update on the client.

See the Transfer data over an IP network section for detailed instructions on setting up a
link.
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7 Technical information

7.1 .ini preferences file

The preference file, plw.ini, contains two sections: [General] and [Preferences].
These sections contain the following items:

[General]

  DataPath
Alternate path for data files

  UserName
Text to display in the footer for printed reports 

  Language
Language code (see Language dialog box)

  Serial
Serial number for the TC-08 software

  VersionWarning
Version warning state (tells to check web for update)

[Preferences]

  Colour0 - (0 to 16)
Colour of a graph component in COLORREF format (see Colours dialog box)

  CustomColour0 - (0 to 15)
Custom colors used by the standard windows colour selection dialog box in 
COLORREF format (see Colours dialog box)

  BeepOnReading 
  BeepOnLamp
  BeepOnAlarm
Sound options (see Sounds dialog box)

  Fahrenheit 
See Temperatures dialog box (Yes = Fahrenheit, No = Celsius)

  QuickSampleMs
Minimum sample interval for which AC/frequency measurement is possible (default is
1000 ms). Warning: reducing this will significantly slow down the sampling speed of
some ADC units by preventing the Quick sample mode from being active at sampling
intervals up to 1000 ms.

  AllowStandby
By default, the TC-08 software prevents a PC from automatically going to the
power-saving Standby mode.  If AllowStandby=Yes then the TC-08 software will not
interfere with power-saving operations.

  DemoMode
Use to override the installation setting for whether or not the TC-08 software is in Demo
mode.  However, the product drivers will need to be reinstalled if the TC-08 software
was installed in Demo mode (Yes = Demo, No = Normal).

Note: Do not attempt to save your data directly to a floppy disk.
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7.2 .plw data file

The .plw file has a fixed-length header, followed by a data record for each sample. It is
terminated by a copy of the .pls file that was used to record it.

The first two-byte field of the header contains the length, in bytes, of the header. The
remaining fields are as follows:

UNS16: header_bytes; the length, in bytes, of this header
char: signature [40]; "TC-08 Windows Software"
UNS32: version;
UNS32: no_of_parameters;  no of parameters recorded
UNS16: parameters [50]; 
UNS32: sample_no;  same as no_of_samples, unless wraparound occurred
UNS32: no_of_samples;  number of samples recorded so far
UNS32: max_samples; 
UNS32: interval;  sample interval
UNS16: interval_units;  0=femtoseconds, 4=milliseconds, 5=seconds, 6=minutes,

7=hours
UNS32: trigger_sample; 
UNS16: triggered; 
UNS32: first_sample;  
UNS32: sample_bytes;  length of each sample record
UNS32: settings_bytes;  length of settings text after samples (copy of .pls file)
UNS32: start_date; 
UNS32: start_time; 
INT32: minimum_time; 
INT32: maximum_time; 
char: notes [1000]; 
INT32: current_time; 
UNS8: spare [78]; 

Note: Do not attempt to save your data directly to a floppy disk.
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7.3 .pls settings file

The TC-08 software uses recorder.pls to hold information about the current recording
session. A separate file, player.pls, holds information about the current player
session.

The user can use the Save as... option in the File menu to save the current settings in a
named .pls file. These details can later be loaded to carry out a new test with the same
settings.

The recorder.pls file is also written to the end of each .plw data file and is
automatically reloaded when an old .plw file is loaded.

All settings files are in windows .ini format and could be edited using a text editor,
although this is not recommended. The file contains the following sections:

[Sampling]
This section contains details of recording and sampling.
[General]
Numbers of parameters, converters, etc
[Converter 1]
Generic converter details - type and port
[Unit 1]
Type-specific converter details
[Unit 1 Measure 1]     
Details about a measurement from converter 1
[Parameter 1]     
Information on the monitor window
[Recorder]
Information on the recorder window
[Graph1]
Information on the graph window
[XYGraph1]
Information on the XY graph window
[Spread1]
Information on the spreadsheet window
[File]
Current filename

Note: Do not attempt to save your data directly to a floppy disk.
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7.4 Scaling file

This file is a text file containing information in the following format:

The first few lines define a number of keyword parameters. These lines are in the same
format as a Windows .ini file, with a keyword, an equals sign and then a value, for
example:

Units=°C

One of the keyword parameters is the scaling method and must always be included. The
remaining parameters are optional. The keywords for the optional parameters are listed
below. 

After the optional parameters, the actual scaling information appears in the same format
as it is entered in the scaling dialog box.

The scaling method can be specified either in English or in the currently selected
language. If the scaling method is specified in English, it will be understood regardless of
what language is selected.

For a lookup table with just two pairs, the file would look like this:

Notes=LM35CZ Temperature sensor
Type=Table
Units=°C
-0.02       -20
 0.1 100

For an equation, the file would look like this:

Notes=Temperature in Fahrenheit from LM35CZ
Type=Equation
32 + x *0.005555

The  optional parameters are:

  Notes
You can include one or more lines of notes to explain what this scaling file is to be
used for. The first few lines of the scaling file are displayed when the file is loaded, so
the notes give the user an indication that they have loaded the correct scaling file.

  Units
The unit text to be shown on graphs, spreadsheets etc

  Width
The field width when the parameter appears in spreadsheets

  Places
The number of decimal places to display

  MinValue
The minimum value for graphs

  MaxValue
The maximum value for graphs

Some of the optional parameters will automatically set the fields on the 'Parameter
options' dialog box, for example the units, range etc. See the Parameter options dialog
box for more information on these parameters
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7.5 Command line options

The following command line options can be specified when you start the TC-08 software:

-p Start the TC-08 software in Player mode
-r Restart recording
xxxx.pls Load the settings from xxxx.pls

7.6 Multiple program instances

You can have more than one copy of the TC-08 software running at once. This means
that you can use one copy to examine old data files whilst another copy is collecting a
new data file. You can have more than one 'player' open to examine old files, but only one
recorder is allowed.

To start the TC-08 software as a recorder, click the Recorder icon in the TC-08 program
group.

To start the TC-08 software as a player, you can either click the Player icon in the TC-08
program group or, if you already have a recorder running, select the Player window from
the View menu.

See also the -p option for the startup command.

7.7 DDE

Stands for Dynamic Data Exchange. This is a convenient method of transferring the
current set of readings to other applications. Data is updated continuously, about once per
second.

Data items are identified by three keywords: Application, Topic and Item. The
keywords accepted by the TC-08 software are:

Application PLW
Topic Current
Item Name - parameter name

Value - the current value
Units - the units 
Alarm - the alarm status 

Each DDE request returns a list of values for each parameter.

To read the current values into Excel, type the following command into a spreadsheet cell:

=PLW|Current!Value

To read the current values into Quattro Pro, type in the following command into a cell:

@DDELINK([PLW|Current]Value)

Most application programming languages (C, Delphi, Visual Basic) provide tools to make
DDE requests from other applications.
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7.8 Equation notation

An equation can contain the following items:

  Input parameters
These are represented by X for a measured parameter and A, B, C, D and E for a
calculated parameter. 

  Numbers
These should be in fixed point decimal notation, such as 12.34. Exponential notation,
such as 1.234E1, is not supported.

  Mathematical operators
See below

  Mathematical functions
See below

  Spaces

Operators
The operators follow the normal rules of operator precedence (BODMAS, for "Brackets,
Division & Multiplication, Addition & Subtraction").  If you wish to force a particular order of
evaluation, use brackets.

Notation Description Usage
( ) brackets (x - 5) * 6
- unary minus -x
- binary minus x - 5
+ plus x + 5
* times x * 5
/ divide x / 5

Functions

Name Description Usage Example
exp e^x exp (x) exp (3) = 20.085
log10 log10 log10 (x) log10(100) = 2
ln loge ln (x) ln(20.085) = 3
power power x power 5 2 power 3 = 8
mod modulo (remainder) x mod 5 10 mod 2 = 1
sqrt square root sqrt (x) sqrt(2) = 1.414

7.9 Glossary

.bmp.  Bitmap file format, used for uncompressed images. The bitmap format is a very
widely supported generic image format. The files are not usually compressed, and are
therefore very large, but the image quality is very high.

.jpg.  JPEG file format, used for compressed images. JPEG stands for Joint Photographic
Expert Group and is the image format most widely supported across all platforms.

.pls.  TC-08 software settings file. This holds data about the setup of the current recording
session, but does not hold data collected from the converter.

.plw.  TC-08 software data file. This file holds the data collected from the converter, and
ends with a copy of the .pls the TC-08 software settings file.

.prn.  The print file exported from the spreadsheet window is formatted with
'tab-separated values'. The data fields are separated by tabs and each record is
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separated with a carriage return, as in the following example:

Time (s) Sound Level (dBA)
0 55.5  
1 55.4  
2 56.2  

.scl.  Scaling file.  It contains data about a specific type of sensor. Some files, such as pt
100.scl, are installed with the application and can be loaded from the Parameter scaling

dialog box whilst the 'Use scaling from file' option is selected.  The data can be used to
calibrate the sensor, or to scale it to a particular measurement unit.

.wmf.  Windows Metafile.  The TC-08 software uses this vector-based format because it
produces scalable images and has a small file size.

Client.  The client computer requests and receives information from a server. Therefore
when setting up an IP Network arrangement, the server is attached to the converter and
passes data to the client, which then receives and records it.

COLORREF.  'C' language typedef of unsigned long used by windows. For more
information, search http://msdn.microsoft.com/library/.

IP socket.  Internet Protocol socket. An IP socket simply defines the data transfer
protocol and the socket via which the server and client communicate. The default socket
number is 1050. Note: An IP socket is not a physical port.

Port.  A physical connector, on the computer, to which converters are attached.  The USB
TC-08 should be connected to the USB port.

Server.  Receives data requests from the client and returns data as a response. When
you set up an IP Network, therefore, the server is attached to the converter and passes
data to the client, which then receives and records it.

USB 1.1.  Universal Serial Bus (Full Speed). It can support data transfer rates up to 12
Mbits per second. USB 1.1 was superseded by USB 2.0.

USB 2.0.  Universal Serial Bus (High Speed). It can support data transfer rates up to 480
Mbits per second and is the successor to USB 1.1.

http://msdn.microsoft.com/library/
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WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and workmanship for a
period of 13 months from date of purchase. OMEGA’s WARRANTY adds an additional one (1) month
grace period to the normal one (1) year product warranty to cover handling and shipping time. This
ensures that OMEGA’s customers receive maximum coverage on each product. 
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer Service
Department will issue an Authorized Return (AR) number immediately upon phone or written request.
Upon examination by OMEGA, if the unit is found to be defective, it will be repaired or replaced at no
charge. OMEGA’s WARRANTY does not apply to defects resulting from any action of the purchaser,
including but not limited to mishandling, improper interfacing, operation outside of design limits, 
improper repair, or unauthorized modification. This WARRANTY is VOID if the unit shows evidence of 
having been tampered with or shows evidence of having been damaged as a result of excessive corrosion;
or current, heat, moisture or vibration; improper specification; misapplication; misuse or other operating
conditions outside of OMEGA’s control. Components in which wear is not warranted, include but are not 
limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However, 
OMEGA neither assumes responsibility for any omissions or errors nor assumes liability for any
damages that result from the use of its products in accordance with information provided by
OMEGA, either verbal or written. OMEGA warrants only that the parts manufactured by it will be
as specified and free of defects. OMEGA MAKES NO OTHER WARRANTIES OR 
REPRESENTATIONS OF ANY KIND WHATSOEVER, EXPRESS OR IMPLIED, EXCEPT THAT OF TITLE,
AND ALL IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION OF 
LIABILITY: The remedies of purchaser set forth herein are exclusive, and the total liability of 
OMEGA with respect to this order, whether based on contract, warranty, negligence, 
indemnification, strict liability or otherwise, shall not exceed the purchase price of the 
component upon which liability is based. In no event shall OMEGA be liable for 
consequential, incidental or special damages.
CONDITIONS:  Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) as a “Basic
Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or activity; or (2) in medical
applications or used on humans. Should any Product(s) be used in or with any nuclear installation or
activity, medical application, used on humans, or misused in any way, OMEGA assumes no responsibility
as set forth in our basic WARRANTY/DISCLAIMER language, and, additionally, purchaser will indemnify
OMEGA and hold OMEGA harmless from any liability or damage whatsoever arising out of the use of the
Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department. BEFORE
RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN AUTHORIZED RETURN
(AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT (IN ORDER TO AVOID
PROCESSING DELAYS). The assigned AR number should then be marked on the outside of the return
package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to prevent
breakage in transit. 

FOR WARRANTY RETURNS, please have the 
following information available BEFORE 
contacting OMEGA:
1. Purchase Order number under which the product

was PURCHASED,
2. Model and serial number of the product under

warranty, and
3. Repair instructions and/or specific problems 

relative to the product.

FOR NON-WARRANTY REPAIRS, consult OMEGA
for current repair charges. Have the following
information available BEFORE contacting OMEGA:
1. Purchase Order number to cover the COST 

of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems 

relative to the product.

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. This affords
our customers the latest in technology and engineering.
OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2007 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without the
prior written consent of OMEGA ENGINEERING, INC.
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Where Do I Find Everything I Need for 
Process Measurement and Control? 

OMEGA…Of Course!
Shop online at omega.com

TEMPERATURE
�� Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies
�� Wire: Thermocouple, RTD & Thermistor
�� Calibrators & Ice Point References
�� Recorders, Controllers & Process Monitors
�� Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
�� Transducers & Strain Gages
�� Load Cells & Pressure Gages
�� Displacement Transducers
�� Instrumentation & Accessories

FLOW/LEVEL
�� Rotameters, Gas Mass Flowmeters & Flow Computers
�� Air Velocity Indicators
�� Turbine/Paddlewheel Systems
�� Totalizers & Batch Controllers

pH/CONDUCTIVITY
�� pH Electrodes, Testers & Accessories
�� Benchtop/Laboratory Meters
�� Controllers, Calibrators, Simulators & Pumps
�� Industrial pH & Conductivity Equipment

DATA ACQUISITION
�� Data Acquisition & Engineering Software
�� Communications-Based Acquisition Systems
�� Plug-in Cards for Apple, IBM & Compatibles
�� Datalogging Systems
�� Recorders, Printers & Plotters

HEATERS
�� Heating Cable
�� Cartridge & Strip Heaters
�� Immersion & Band Heaters
�� Flexible Heaters
�� Laboratory Heaters

ENVIRONMENTAL
MONITORING AND CONTROL
�� Metering & Control Instrumentation
�� Refractometers
�� Pumps & Tubing
�� Air, Soil & Water Monitors
�� Industrial Water & Wastewater Treatment
�� pH, Conductivity & Dissolved Oxygen Instruments
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